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About DriveHQ FileManager 

DriveHQ FileManager is a flagship application for DriveHQ’s Cloud IT service (incl. Cloud File Server, 

Online Storage, Sharing, Publishing, Collaboration and Folder Synchronization features).  

DriveHQ FileManager has a very simple user interface. It is like Windows Explorer or FTP client, 

moreover, it can manage both cloud and local files. It is seamlessly integrated with DriveHQ’s cloud 

IT service, users can easily access the following features: 

o Drag and drop folders/files between local and cloud storage. 

o Synchronize local folders with cloud folders.  

o Directly edit cloud files & save back to the cloud with automatic file locking.  

o Share or publish cloud folders, set share permissions, get static file URLs. 

DriveHQ FileManager is also available for Mac with similar GUI and features. A mobile version of 

FileManager is available for Android, iOS and Windows Store. 

  

1. Advantages of DriveHQ FileManager 

DriveHQ FileManager works like Windows File Explorer.  It displays local files on one side and cloud 

files on the other side. You can easily drag and drop files / folders between local folders and cloud 

folders. It has the following main benefits: 

o Directly edit cloud files & save back to the cloud without folder synchronization. 

o Securely share files with people in remote locations, incl. colleagues and clients. 

o Group sharing and collaboration with folder access control. 

o Powerful folder synchronization features. 

There are a lot more advantages, which will be described in the features section. 

2. DriveHQ FileManager Features 

DriveHQ FileManager has a lot of great features, incl.: 

• Easy, Reliable and Efficient File Uploading & Downloading with Drag-n-Drop 

o Supports Windows Explorer-like and FTP-like interface. You can easily drag and drop files 

/ folders between your local storage and cloud storage. It can upload/download any 

number of files reliably and efficiently. 

 

• Folder / File Sharing with Access Control 

o You can select a folder / file and share it with other people, incl. non-DriveHQ members. 

o You can share different folders with different users and set different access rights. 

 



• Folder / File Publishing – Create Static File URLs 

o You can easily select a folder / file and publish it, creating a static URL(s) to the folder / file 

(and files in the published folder). The static file URL(s) can be used in any web pages to 

link to the published file(s) or folder(s). User logon is not needed. 

 

• Powerful Folder Synchronization: 

o You can synchronize a local folder with a cloud folder. 

o You can synchronize multiple PCs by syncing to the same cloud folder. 

o By using shared folders, you can synchronize folders belong to multiple user accounts.  

o You can set one-way or two-way folder synchronization tasks. 

o You can set synchronization schedules. (e.g. real-time, daily or weekly) 

o  You can create multiple sync tasks to sync multiple local folders with multiple cloud folders. 

o You can exclude certain files/subfolders from being sync-ed using wildcard. 

 

• Group Sharing and Collaborations: 

o You can share folders / files to a group, a sub-group or a contact group.  

o You can share different folders to different sub-group(s) or contact-groups with different 

levels of access rights. 

 

• Directly Access and Edit Cloud Files with Automatic File Locking & Unlocking: 

o You can directly access and edit cloud files without folder synchronization. You don’t need 

to keep a local copy of all your files. 

o When double clicking on a cloud file to open/edit it, the cloud file is automatically locked. 

After you finish editing the file, you can click Save to save it back to the cloud. You can 

also click Save As to save it as a new file. The file is saved to a local cache folder first, 

then automatically saved back to the cloud. 

o A locked file is automatically unlocked after you close the file. 

o You can manually lock/unlock a cloud file by right clicking on the file. 

 

• Encrypted Folder 

o You can turn on the Encrypted Folder feature, setup an encryption key, and then upload 

files / folders to the encrypted folder. Files uploaded to the encrypted folder are 

transparently encrypted by DriveHQ FileManager client software. Files remain encrypted 

on DriveHQ server. The encryption key is never sent to DriveHQ server. So it is extremely 

secure. 

 

• Data Compression for faster upload / download 

o DriveHQ FileManager can automatically compress data for faster upload / download. 

 

• Supports automatic / manual resuming, can reliably transfer files of any size 

o When uploading / downloading very large files, if the network gets disconnected, DriveHQ 

FileManager (and Online Backup) can automatically retry and resume from where it was 

interrupted. You never need to start over again. 

 

• Magic upload 

o If a file has been uploaded before, DriveHQ FileManager can automatic detect it and skip 

the uploading. This can dramatically increase the upload speed. 

 



• Speed limit:  

o When you upload/download a lot of large files, DriveHQ FileManager may use a big 

percentage of network bandwidth. To avoid DriveHQ FileManager from using too much 

bandwidth, you can set the speed limit for DriveHQ FileManager. 

3 Get Started with DriveHQ FileManager 

3.1 Download DriveHQ FileManager 

You can download the latest version DriveHQ FileManager from: 

https://www.drivehq.com/downloads/downloadfilemanager.aspx 

There are two versions of DriveHQ FileManager: the 32-bit version and 64-bit version. Most (new) 

PCs are 64-bit now. 

You should install the 32-bit version on 32-bit operating system and 64-bit version on 64-bit version 

operating system. In fact, the 64-bit version cannot be installed on 32-bit version operating system; 

the 32-bit version can be installed on 64-bit version operating system, however, some minor features 

may not work. The download page usually can automatically detect your OS type and let you download 

the correct version. You can also manually select a version to download. 

3.2. Install DriveHQ FileManager on your computer 

After you have downloaded the software, please double click on the installer file to launch the setup. 

Follow the wizard step by step and it will install DriveHQ FileManager on your computer. Most features 

will work immediately. Certain Windows Explorer integration feature will work after you reboot your 

computer.  

Trouble shoot installer problems: 

(1) Make sure you have the right to install software on your computer. You need to log on as a system 

admin on the PC. Some organizations may not allow employees to install software on their computers. 

Public computers, such as those in a library, usually do not allow any users to install any software. 

(2) Make sure you don’t have any anti-virus or security software that blocks DriveHQ FileManager 

installer. 

(3) Some anti-virus / security software may change the downloaded .exe file extension to a different 

extension. In this case, you need to change the file extension back to .exe before you double click on 

the FileManager installer file. 

3.3. Start DriveHQ FileManager 

https://www.drivehq.com/downloads/downloadfilemanager.aspx


It is recommended to visit the DriveHQ FileManager download page and click on “View FileManager 

Live Demo” link to see how FileManager works. 

The first time you start DriveHQ FileManager on a computer, it will display the following dialog. 

 

Run DriveHQ FileManager for the 1st time 

If you don’t have an account on DriveHQ.com, please click “Sign Up” to create a new account. You 

need to enter your username, password, confirm password and email address. Note DriveHQ has 

millions of users, popular usernames are often taken. Please use a unique username. You can 

optionally click “Advanced Option” to sign up a new account on DriveHQ.com website and provide 

more optional information. 

 



Sign up a new account dialog 

After you click Submit, it will create your account and send an Activation Email to your email address. 

Please check your email and click the activation link in the email to activate your account.  

Usually the activation email is delivered in a few minutes. If you don’t receive the email, please check 

your junk/bulk mail folder. Your email server might incorrectly filter the email. If so, you can change 

your email address by logging on to www.DriveHQ.com website with your username and password. 

You cannot really log in, but you can change the email address and request the activation email to be 

sent again.  

If you have a DriveHQ account, please log on with your username and password. It will display the 

initial screen of DriveHQ FileManager, as shown below: 

 

DriveHQ FileManager initial screen (after logon) 

 

You need to decide whether you want to use DriveHQ FileManager for folder synchronization. With 

DriveHQ FileManager, you can directly open, edit and save cloud files without folder synchronization.  

http://www.drivehq.com/


If you’re already familiar with other folder sync services, you probably want to create the default folder 

sync task(s). Otherwise, you can click Cancel. If you change your mind later, it is ok. You can change 

it later. 

After you click Ok or Cancel, it will display the FileManager main window: 

 

On top of the screen, you can see the main menu and toolbar; on the left-hand side, it displays cloud 

files / folders in your DriveHQ account; on the right-hand side, it displays your local files / folders. At 

the bottom of the screen, it displays the transfer tasks with progress info. 

4. Using DriveHQ FileManager for Cloud Storage 

Launch DriveHQ FileManager and log on, it will display the Main Screen as shown above. 

By default, it displays the cloud files on the left-hand side and local files on the right-hand side; this is 

like many FTP client programs. You can click on the display button to change the layout. 

 



Click on the display button to change the layout 

After you click on the display button, you it will display a pull-down menu: 

• Show cloud files only; 

• Show local and cloud files (the default); 

• Show local files only 

If you select “Show Cloud Files Only”, it will display the following dialog: 

 

Show Cloud files only 

When showing cloud files only, it displays the cloud folder tree on the left-hand side; on the right-hand 

side, it displays the selected cloud folder contents. 

4.1 “DriveHQ Root”, “My Storage”, “DriveHQ Share” and 

Sample Folders/Files/Shares 



In the left-hand side of DriveHQ FileManager window, the root folder is “DriveHQ Root”. It is not a real 

folder. It is a virtual folder containing a few virtual folders, mainly: 

• My Storage: It is a virtual root folder that contains all folders and files in this account. It is not a 

real folder. You can create files/folders in it, but you cannot delete the virtual folder itself. “My 

Storage” is usually referred with the folder path of “\”. 

Folders / files inside of “My Storage” are real folders / files. These folders / files are owned by 

this account. By default, folders and files are secure and private if they are not shared with others 

or published for anybody to access. Users always have full access to files / folders in their own 

“My Storage”, incl. create folders, upload files, edit / delete / download files / folders, share / publish 

folders or files, etc. 

• DriveHQ Share: It is a virtual folder that contains all folders / files shard to this user by other 

DriveHQ members. In the above screenshot, you can find 3 folders in the “DriveHQ Share” virtual 

folder. They are not real folders. They are the usernames who shared folders with this user. 

“DriveHQ Share” is often referred with the folder path of “\\”. 

As you expand the folder “DriveHQ Share”, you can see the following folder paths: 

[\DriveHQ Share]\USER_NAME\SHARE_NAME\FOLDER_NAME\... 

Or  

\\USER_NAME\SHARE_NAME\FOLDER_NAME\... 

Where “DriveHQ Share”, “USER_NAME” and “SHARE_NAME” are all virtual folders. Virtual folders 

cannot be deleted or renamed. So when you right click on a virtual folder, most of the popup menu 

items are disabled. If you want to remove a USER_NAME or SHARE_NAME from the “DriveHQ Share” 

virtual folder, you can ask the USER_NAME to stop sharing folders with you (or you can block the 

user from sharing folders with you). 

Usually you cannot upload files to a “virtual folder”, except the “My Storage” virtual folder and shared 

folder like \\USER_NAME\SHARE_NAME\. 

Folders inside of a virtual folder like \\USER_NAME\SHARE_NAME\ are real folders. They are 

accessible at: \\USER_NAME\SHARE_NAME\FOLDER_NAME\.They are not your folders. They belong 

to USER_NAME. If USER_NAME logs on to DriveHQ, the folder will be accessible in his “My Storage”. 

file://///user_name/SHARE_NAME/
file://///USER_NAME/SHARE_NAME/
file://///USER_NAME/SHARE_NAME/FOLDER_NAME/


 

Right click on a real folder  

As shown in the screenshot above, the “DemoGuest1” folder is a real folder. When you right click on 

it, it pops up a menu, where you can select an option to “Cut”, “Copy”, “Delete”, “Rename”, “Download”, 

“Share” or “Publish” the folder. You can also select the Properties to find more detailed info about the 

folder. 

Please note Folders in “DriveHQ Share” (incl. its subfolders) cannot be shared or published by this 

user. Only a folder’s (or file’s) owner can share the folder / file. 

Sample Folders, Files, Shares and Publishes 

When you sign up a new account on DriveHQ.com, the system automatically creates a few sample 

folders, files, shares and publishes. It is similar to a new PC. You can use the sample folders. They 

are the same as other regular folders. You can delete them if you really like to. Otherwise, you can 

keep them even if you don’t use them. 

There is a shared sample folder from DriveHQ Webmaster: 

\\webmaster\ShareSample 

This share is used as an example. It includes instructions about folder sharing. If you want to “delete” 

it, you can click Options -> Folder Options. Then click “Set cloud folder options” to set the option on 

DriveHQ.com.  

file://///webmaster/ShareSample


If you are a group member, you might see two default Shared Folders: 

\\GroupOwnerUsername\GroupRead  

and  

\\GroupOwnerUsername\GroupWrite  

The group owner can delete these two sample folders from his My Storage, or Delete the shares from 

his Manage My Shares page, or set the group option not to create the two default group-shared folders.  

4.2 Upload / Download / Manage Files and Folders 

DriveHQ FileManager can reliably upload/download files of any size. It is very easy to upload / 

download / manage files using DriveHQ FileManager. You can drag and drop files / folders from 

Windows Explorer to any real cloud folder. A real cloud folder is:  

• Any folder in “My Storage” (i.e. your own folders). 

 

• A folder shared with you by another user, such as: 

\DriveHQ Share\USER_NAME\SHARE_NAME  (and its subfolders) 

and it is shared with a correct permission level.  

 

Please note: “DriveHQ Share”, “DriveHQ Share\USER_NAME” and “DriveHQ 

Share\USER_NAME\SHARE_NAME” are virtual folders. You cannot drag and drop files into these 

virtual folders. 

You can also drag and drop files / folders between the left and right side of DriveHQ FileManager.   

There are 3 more ways to upload / download / copy / move files / folders: 

• You can use the standard Windows short-cut key combinations, such as: “Ctrl + C” for copy; “Ctrl 

+ V” for paste; “Ctrl + X” for Cut. 

• You can select a folder(s) / file(s), then click on the Edit menu, and select “Cut”, “Copy” and 

“Paste”. 

• You can right click on the selected File(s) / Folder(s) and select from the popup menu “Cut”, 

“Copy”, “Paste”, “Delete” and “Rename”, etc. 

file://///GroupOwnerUsername/GroupRead
file://///GroupOwnerUsername/GroupWrite


 

Access DriveHQ actions menu by right clicking on the select files & folders. 

After you drag and drop or copy / paste multiple files / folders, it will start uploading / downloading 

immediately. The files are added to the upload / download task list at the bottom of the screen. See 

the screenshot below: 



 

FileManager uploading multiple files / folders 

As you can see from the above screenshot, when dragging multiple files / folders from the local storage 

to the cloud storage, files are added to the transfer task list. You can see the progress of each file as 

well as the overall progress of all files. You can also find the local (source) file paths and cloud 

(destination) file paths, the transfer speed and remaining time.  

Please note the uploading / downloading speed changes from time to time; it is dependent on many 

factors, such as file size, file type, whether the file has been uploaded by any other users, etc. It is 

also dependent on the network routing, so the actual speed varies from time to time and location to 

location. The estimated time is not accurate. DriveHQ has virtually unlimited network bandwidth. 

However, the actual upload speed is limited by the specific route from your location to our servers. 

The connection from your ISP to DriveHQ servers will need to go through many Internet hops (links). 

The slowest link will determine your actual speed. DriveHQ FileManager has developed many 

technologies to improve the upload / download speed.  

If during uploading / downloading, the network connection is dropped briefly, it can automatically retry 

and resume (or manual resume) when the connection is re-established. You can also manually click 

on the Stop button to stop (pause) uploading / downloading. You can resume the transfer later, or 

delete the un-finished transfer tasks by clicking on the “Delete” button. (Deleting a file’s transfer 

task/progress info will not delete the source file.) 



4.3 Directly Edit Cloud Files and Save Back to Cloud 

With FileManager, you can directly edit a cloud file and save changes back to the cloud. You don’t 

need to manually download/upload the file; nor do you need to sync the folder.  

Just double click on a cloud file to open it in the default program. E.g. you can edit a .docx file in 

Microsoft Word. After you finish editing, just click Save in MS Word. It will be saved to a local cache 

folder first and then automatically synced back to the cloud instantly. 

You can also save the file as a different name. e.g. you can save a .docx file as a .pdf file using MS 

Word. Just save the new file in the same local cache folder and it will be automatically saved back to 

the cloud.  

This method is better than folder synchronization. You don’t need to sync your cloud storage. It saves 

time, bandwidth and a lot of local storage space. 

 

4.4 The “Recycle Bin” Folder and Restore Deleted Files 

If you delete a cloud file/folder in your account, it is moved to your “\Recycle Bin” folder in your “My 

Storage” root folder. Files/folders are kept there for 2 weeks, then they are purged. You can use 

“Shift-Delete” to delete and purge a file/folder. You can restore a deleted file/folder before they are 

purged. Please see the screenshot below. 

 

You can use the Restore option on files/folders with “DeletedItem” in the name; otherwise, you can 

manually copy and paste the file/folder and then manually update the name.  



If you delete a file/folder in a folder shared with you by another user, then it is moved to the “Recycle 

Bin” folder of that user (the file owner). The file owner can log on to his FileManager and restore the 

file/folder. 

The Recycle Bin option can be turned off from your DriveHQ.com account options page. 

4.5 File History and Versioning 

After you edit a cloud file and save it, DriveHQ system can keep the old version and save the new 

version. By default, it can keep up to 10 versions. It will use additional storage to save the old 

versions. You can turn off this option from your DriveHQ.com account options page, or you can 

change the maximum number of versions to 2 - 100.  

If you accidentally overwrote / corrupted a file, you can use the file versioning feature to restore an 

older version. To do so, just right click on the cloud file and select History, see the screenshot below: 

 

It will display a list of file versions as follows: 



 

You can select a version and click Download to download it to your local PC, or click Rollback to roll 

back the cloud version.  

 

4.6 Detail View and Thumbnail / Icon View 

DriveHQ FileManager can display folders using Thumbnail / Icon / Detail Views. By default, it displays 

folders in detail view. You can change it to other view by clicking in the toolbar, as shown below: 



 

Change folder view to thumbnail, icon or detail view 

4.7 View File Properties, Edit File / Folder Caption & 

Description 

From DriveHQ FileManager, select a cloud file, and then click on the Properties button in the small 

toolbar, as shown below: 

 

File / Folder properties button 

It will pop up a Properties dialog, as shown below: 



 

File / Folder Properties and Edit Caption / Descriptions dialog 

You can see the file/folder size, cloud path, create time, modify time, caption and description. You can 

also edit the caption and description field and click on Apply to save the change. This feature is very 

useful if you need to caption a lot of files / pictures. 

4.8 DriveHQ Control Panel 

From the DriveHQ Root folder, click DriveHQ control panel, you can see the following screen: 



 

DriveHQ FileManager Control Panel screen 

DriveHQ Control Panel is a virtual folder linking to many functions for setting up your account options 

and managing your “shares” and “publishes”. The same functions can also be accessed from the Tools 

menu.  

4.9 Cloud Shortcuts and Favorite Folders (Bookmarks) 

If you need to access a few cloud folders frequently, you don’t have to navigate to those folders 

again and again. There are two solutions: Cloud Shortcuts, and Favorite Folders (Bookmarks). 

4.9.1 Cloud Shortcuts 

A cloud shortcut file is like a local shortcut file, except it links to a cloud folder. You can create a 

cloud shortcut file and place it on your Windows desktop or in any cloud or local folder. To create a 

cloud shortcut file, right click on a cloud folder, then select “Create a Cloud Shortcut on Desktop”. 

See the screenshot below: 



 

Create a cloud shortcut file on your Windows desktop 

It will create a cloud shortcut file and save it on the desktop, see the icons as follows: 

 



The shortcut file can be copied or moved to any local or cloud folder. If you double click on it, it will 

open DriveHQ FileManager and automatically navigate to the destination cloud folder. In the 

example below, it links to:  \FileServer\SupportDepartment\Manuals. See the screenshot below. 

 

Double click the cloud shortcut, FileManager opens the destination folder 

4.9.2 Favorite Folders (Bookmarks) 

If you need to access certain folders frequently, you can add them to your Favorite Folders (Bookmarks). 

Please see the screenshot below: 

 

Select a folder and add it to Favorites 



Click “Add the selected folder to Favorites”, it will display: 

 

Click Save to finish adding it to Favorites. Now you can click the Favorites icon and quickly navigate to 

the destination folder. See the screenshot below: 

 

 

4.10 Search Files/Folders (Regular and Full-text Search) 

You can click the search icon to search files/folders in the current folder: 



 

Click the Search icon to search files/folders in a folder 

If you search in the cloud folder, then it displays the search files/folders dialog: 

 

By default, you can search files/folders by:  

- File/folder name (supports partial match) 

- File modify time (range) 

- File size (range) 

If you ordered DriveHQ’s Full-Text search service, then you can also search files based on 

keywords in file contents. Please note that Full-text Search is an enterprise feature. It requires a lot 

of extra database storage and CPU power. It is available to enterprise customers as an add-on 

service. Please contact DriveHQ sales if you are interested in it. 

With full-text search service, the system will index keywords in MS Office, PDF, Text, HTML, XML 

and other indexable files. If you have a lot of such files, full-text search is very efficient and useful.  

Click Search, it will display a list of matching files/folders. 



 

The search result screen 

The result files/folders are displayed like a regular folder but with different column headers. You can 

right click on a file/folder name in the search result and open the folder that contains the file/folder. 

4.11 Attach Cloud Files to a New (Outlook) Email 

If you are composing a new Outlook email and you want to attach some files from your cloud 

storage, you can drag and drop the cloud files in FileManager to your Outlook new email. Please see 

the screenshot below: 

 

 

5. Share Files and Folders 



Using DriveHQ FileManager, it is very easy to share folders online. Just log on to DriveHQ 

FileManager, select a folder (in My Storage) and click on the Share button.  

You can share a folder with DriveHQ members or non-members, and set a permission level; you can 

share folders with different users, subgroups and/or contact groups and set different permissions; you 

can share the same folder multiple times (using different share names). Each user can only see the 

folder(s) shared with him/her. 

5.1 Group Account Management (for Business) 

This section is for group administrators or business account owners. Other users can skip it.  

Like a local file server with multiple user accounts, you can use DriveHQ’s group account feature to 

create multiple sub-users and subgroups.  The free service only offers 1 free sub-user license. If you 

need more than 1 sub-user, you can order an enterprise subscription.  

To create sub-accounts, there are two options: 

Option 1: Use the Group Admin feature. Log on to DriveHQ.com website, then click the Group 

Admin link. Please see the screenshot below. 

 

The Group Admin feature 

Click “Create” as shown above, it will display the following screen: 



 

You will need to enter the sub-username, password, confirm password; you do not have to enter an 

email address, just check the “Use DriveHQ email” checkbox.   

For the User Type dropdown box, you can select: 

o Regular Member 

It is designed for regular employees. 

 

o Guest User 

It is usually for external clients. Guest users cannot access folders shared with the entire 

group, incl. the default GroupRead and GroupWrite folders. They can access folders 

shared with them explicitly. 

 

o Subgroup Administrator 

It is designed for department managers or branch office managers. When you create a 

subgroup administrator, it implicitly creates a subgroup with the same subgroup name 

being the subgroup administrator’s username. A subgroup administrator can manage a 

subset of the group members. If you have a lot of sub-users, you can create nested 

subgroup administrators. 

 

o Group Administrator  

Designed for the IT Manager(s). A group administrator can create, manage and log on as 

other group members, except the Group Owner.  



Assign to Subgroup: if you have already created a subgroup administrator(s), you can assign a 

new sub-user to a subgroup (A subgroup administrator implicitly represents a subgroup). You do not 

have to assign a sub-user to a subgroup.  

Max Storage Space: The default value is 0 MB. It means the sub-account does not have any 

storage space. The sub-user cannot upload any files into his own “My Storage”. He cannot create a 

new file/folder in his “My Storage”.  This forces the sub-user to only use a shared folder(s). The 

group owner can share a folder with the sub-user and set a specific access permission. 

If you set the value to a positive number, then the sub-user will be able to store files/folders in his 

own My Storage. Please note each user has his own “My Storage”. The group owner cannot directly 

see files/folders in a sub-user’s My Storage. However, the Group Owner can log on as a sub-user 

and see the files/folders. Allocating storage space to a sub-user(s) will reduce the Max Storage 

Space allocated to the Group Owner. 

Max Monthly Download Bytes: The default value is 0 MB. It means the sub-account does not have 

any download bytes. The sub-user cannot download any files from his own “My Storage”, but the 

sub-user can download files from a folder shared with him. In this case, he uses the file owner’s 

download bytes.  

If you set the value to a positive number, then the sub-user will be able to download files/folders from 

his own My Storage. It will also reduce the Max Monthly Download Bytes allocated to the 

Group Owner.  

Option 2: Use Active Directory Integration and SSO service.  

For large enterprises with many users, DriveHQ offers an add-on service: Active Directory 

Integration and SSO service. You can use our Active Directory Integration Agent software to batch 

import accounts from your Active Directory domain to your DriveHQ Group Account. You can 

enable/disable SSO for individual users. With SSO, your users can log on to DriveHQ account with 

their Active Directory domain email addresses and passwords. 

After sub-accounts are created, the group admin can make changes to sub-accounts, incl. change 

username/password, disable/enable/delete an account, re-allocate storage space and monthly 

download bytes, etc.  

5.2 Share a cloud folder 

You can select a cloud folder in your account and click on the Share button, or right click on the folder 

to share it. 



 

Right click on a folder or click the Share button 

It will pop up a new dialog: 

 

Share a folder and set permission dialog 

The default share name is the same as the folder name, you can change the share name and 

description. If the folder has been shared/published before, you must use a different share name to 

share it again, or use the Manage My Shares feature to edit the existing share.  



By default, all files and subfolders in this folder are shared. If you don’t want to share some files / 

subfolders, you can move them out of this folder, or you can exclude them by checking the radio button 

of “Exclude folder/file names in Share Root”. You can enter multiple file or folder names and separate 

them with “|”. Only files and subfolders immediately in this folder can be excluded.  

The permission level can be set to one of following levels (in the incremental order): 

• View file / subfolder list only 

• Read / download files only 

• Add / upload files 

• Add & Edit files 

• Full access 

Please note a higher level permission includes all previous permissions.  

In the Share-to field, please enter the email addresses or DriveHQ usernames of the persons who you 

want to share the folder with. If a person does not have a DriveHQ account, or if you don’t know the 

person’s DriveHQ username, you can enter the person’s email address. You can enter multiple 

usernames / email addresses separated by “,” or “;”. 

Group Folder Sharing and Collaboration 

If you have a group account, then you can check the checkbox “Share to group”, which shares the 

folder to all members in the same group except guest users. You can also: 

• Click the “Select Group Members” button to add group members into the Share-to list. You can 

also share a folder with a subgroup(s). All sub-users in the subgroup are automatically shared with. 

If a sub-user is removed from the subgroup, then he/she will not be able to access the shared 

folder again. 

 

• Click “Select Contacts” button to select users from your contact lists. You can create contact 

groups on DriveHQ’s Webmail. A contact group is like an address book. It contains a list of contacts. 

For folder sharing, we only use the email address field of contacts. When a folder is shared with a 

contact, it means the folder is shared with the email address of the contact. If you share a folder 

with a contact group, then all email addresses in the contract group are shared with.  

 

If you need to share a folder with 100s of users, you must use the group sharing feature. 

---------------------- 

The “If any file changes, send share change notification email” checkbox is available to paid users. If 

it is checked, and if anybody uploads a file into the shared folder later, the software will (request the 

user to) send a “Share change notification” email.  

 



After you click on Ok, the Share is created and a confirmation dialog pops up: 

 

Share created confirmation dialog 

The cloud folder “\My Documents” has been shared. If all Share-to users are DriveHQ members, then 

it is not necessary to send the share notification email. The “share-to” users can log on to 

www.drivehq.com (or other DriveHQ programs such as DriveHQ FileManager, WebDAV Drive 

Mapping Tool, DriveHQ FTP server and DriveHQ FileManager mobile apps) and access the shared 

folder at: 

\DriveHQ Share\YOUR_USERNAME\SHARE_NAME 

In the case of this example, it is: 

\DriveHQ Share\DHQDemo\My Documents 

If you shared the folder with a non-DriveHQ member using his / her email address, then you need to 

send a share notification email. You can send it with DriveHQ’s webmail, or use your own email 

software / service. If you click “Open DriveHQ Webmail”, it will launch a web browser and display the 

default email template: 

 

http://www.drivehq.com/


 

The default share notification email 

You can send the share notification email using your own email account/service and your own email 

client software. You can edit the email body to include your own messages. DriveHQ emails are more 

likely to be filtered / ignored by the recipient. Sending from your own email account might be more 

reliable. 

When a recipient receives the notification email, he can simply click the Share URL and then enter his 

email address to access the shared folder. The permission level will be read-only. If the folder is shared 

with a higher level permission, the user must log in, or sign up a new account on DriveHQ.com first. 

He can then access the shared folder from his “\DriveHQ Share\YOUR_USERNAME\SHARE_NAME”  

with a higher level access permission. 

5.3 Share a local folder online 

From DriveHQ FileManager main screen, you can select a local folder and then click on the “Share” 

button (or right click on a local folder and select “Share it with others”), it will pop up the following 

dialog: 



 

Select a local folder online 

Basically, it will upload the folder to the cloud first. Then it will share the uploaded folder online. This 

cloud sharing method is better than local folder sharing methods: 

• You can share folders / files with remote users, incl. co-workers, friends, customers or 

guests. 

• The folder is shared in the cloud. You can turn off your computer without affecting the 

shared folder.  

5.4 Manage My Shares 

If you need to stop sharing a folder, or want to make changes to an existing share, you can click Tools, 

then click Manage My Shares. 



 

It will display a list of your Shares (shared folders). 

 

You can double click on a share name to edit an existing share. If you want to stop sharing a 

folder(s), just select it and then click Delete. It will delete the share only. Your files/folders will not be 

affected. 

5.5 Access shared cloud folders 

After a cloud folder is shared, it can be accessed by the “Share-to” users online. Whether you shared 

a folder using DriveHQ FileManager or DriveHQ.com website, the result is the same: Users can access 

the shared folder using DriveHQ FileManager, DriveHQ.com website, WebDAV Drive Mapping or FTP. 

If a DriveHQ user shared a folder with you, he can send a “Share notification email”, which has the 

detailed instructions about how to access the shared folder, e.g. a typical share notification email 

includes the following info 



------------------------------ 

There are three ways to access these files: 

1.       If you are a DriveHQ member, please log on to your account and access these files in the 

DriveHQShare folder. 

2.       If you are not a DriveHQ member yet, I recommend you to sign up now using this e-mail 

address. My files will automatically appear in your "DriveHQ Share" Folder. 

3.       You can also access these files by clicking on the Share link in the notification email; you will 

have read-only access. In the “Share Verify” page, enter your email address to access the 

Share. 

Please install DriveHQ FileManager to download all files. It works like Windows Explorer or FTP, 

supports drag-n-drop. 

It can download / upload any size files reliably. Please download it at: 

https://www.drivehq.com/downloads/downloads.aspx 

----------------------- 

If you use DriveHQ FileManager to access the shared folder, you must have a DriveHQ account. If 

you are not a DriveHQ member, you can sign up a free DriveHQ account using the email address that 

received the share notification email. 

If your DriveHQ username or your registered email address is in the “Share-to” list when the other 

user shared the folder, then you can log on to DriveHQ FileManager. The folder(s) shared to you is 

automatically displayed in the special virtual folder: 

\DriveHQ Share\FOLDEROWNER_USERNAME\SHARE_NAME 

Dependent on the permission level of the share, (which is set by the user who shared the folder with 

you), you might be able to access the folder with “View File/subfolder list”, “Read-only”, “Add / Upload”, 

“Add & Edit” or “Full Access” right, etc. 

As an example, USER1 shared a folder “\My Documents” to USER2 with full-access right. USER1 

also shared “\GroupRead” to the whole group with Read-only access and “\GroupWrite” with full-

access right. USER2 can see 3 shared folders in the virtual folder: 

\DriveHQ Share\USER1\ 

Since the folder My Documents was shared with full-access right, USER2 can right click on a blank 

area to create files / folders in it. He can also drag and drop files / folders into this shared folder. 

  

https://www.drivehq.com/downloads/downloads.aspx


5.6 Cloud File Locking (for Group Sharing & Collaboration) 

If a folder is shared with multiple users, and if multiple users edit the same shared file at the same 

time, then the last user may overwrite all previous users’ changes. To avoid it, DriveHQ FileManager 

(and WebDAV Drive Mapping) supports cloud file locking.  

Cloud File Locking cannot be supported if you use Folder Sync, Web Browser or FTP based cloud 

storage services. Thus, most cloud storage services do not support cloud file locking. 

DriveHQ FileManager supports both Automatic and Manual File Locking/Unlocking 

o Automatic File Locking/Unlocking 

When you double click on a cloud file in FileManager, the file will be transparently downloaded 
and opened in the default program for the file type. The cloud file will be automatically locked. 
After you finish editing and saving the file, it will be automatically saved back to the cloud. The 
cloud file will remain locked until you close the file. Other users can open the file for read-only 
access when it is locked.  

o Manual File Locking/Unlocking 

You can manually lock/unlock a file using FileManager. To access it, just right click on a cloud 
file and select Lock/Unlock. This is needed in the following cases: 

(a) You plan to edit a cloud file while your computer is offline, you can lock the file before your 
computer goes offline. 

(b) A user forgot to close a file after he opened (locked) it. If the user is not available to close the 
file, it can be very inconvenient for other users who need to edit the file. Both the file owner 
and the lock owner can unlock the file.  
 
In some cases, a cloud file cannot be automatically unlocked due to application 
crashes, OS crashes, power outages or network outages. In these cases, locks are 
usually set to automatically expire in 1 day. If you need to unlock a file sooner, you can do so 
using FileManager or web browser. 
 

o Manage / View File Lock List 

If you are not sure which files are locked, usually you can find out by looking at the file icons. If 
there is a lock in the file icon, it means the file is currently locked. You can right click on the file 
and select Unlock. 



 

 

If you cannot locate the locked files, or if you want to find who locked your files, You can visit 

the Manage Locks / Lock List page to find all files locked by you and all your files locked by 

other users. 

 

To access the Manage Locks/Lock List page in DriveHQ FileManager, click the Tools menu, 

then select Manage Locked Files; to access from a browser, go to the DriveHQ Start Menu 

and click "My Storage", then click "Lock List". Please see the screenshot below: 

 
Access the "Manage File Locks/Lock List" page from My Storage 

 

It will display a list of file locks including "locks created by you to files of other users" and 
"locks created by other users to your files". If many files are locked, you can search locks 
based on the file name, file path, file owner or lock owner. Please see the screenshot below: 



 
The "Manage File Locks / Lock List" page 

 

6 Publish Files / Folders 

By default, files in your DriveHQ account are secure and private. You cannot link files from other 

websites / web pages.  

To create links to your files / folders, you must use the Publish feature. You can publish a file or folder. 

Publishing a folder is more efficient as all files and subfolders in it are also published. Publishing a file 

is not efficient; and if you change a file after it is published, you need to publish it again.  

Whether you publish a folder using DriveHQ.com website or using DriveHQ FileManager, the result is 

the same.  

6.1 Publish a Folder with DriveHQ FileManager 

Publishing a folder using DriveHQ FileManager is extremely easy. You just select a cloud folder in 

your account and click the Publish button, or right click a folder and select “Publish it and create a link”. 



 

Right click a cloud folder, or select it and click Publish 

It will pop up a “Publish a cloud folder” dialog, as shown below. 

 

Publish a cloud folder dialog 

From the above dialog, enter your Publish name, description and permission, check the “Yes, I agree” 

checkbox, then click Ok. The publish name must be unique in your account. If you shared/published 

a folder with the same publish name, you must change the Publish Name in this dialog.  



If the folder is published successfully, you can see the confirmation dialog with Publish URL info: 

 

Publish confirmation dialog with Publish URL 

You can click on “Copy URL” to copy the folder’s publish URL to the clipboard, which you can paste it 

into other applications, e.g. Notepad, Word, or any HTML editor. Click Cancel to close the dialog. 

You can more efficiently get multiple file / folder publish URLs. Just visit any published folder, select 

files / folders in it, then right click on the files / folders, select Show Publish URLs. It will open a new 

dialog as follows: 



 

Get files / folders’ publish URLs (static links) 

To get the publish URLs, please right click on the selected folders / files, then click on Show Publish 

URL. It pops up a dialog as shown below: 



 

Show Publish URLs dialog 

You can copy the publish URLs into your Windows clipboard and paste them into other applications, 

such as Notepad, Word or any HTML editors. 

The above publish URLs have a pattern of: 

https://www.drivehq.com/file/df.aspx/publish/OWNER_USERNAME/PUBLISH_NAME/FILENAME 

If you want to hide your username and folder name, you can click on the “Show Safe URL(s)” button, 

which will change the Publish URLs into a new format as shown below: 



 

Show Safe Publish URL 

The Safe Publish URLs hide the username, publish name, folder name and filename info. So the URL 

is more secure; moreover, Safe URLs are guaranteed not to have any special characters that may 

affect the validity of a URL.  

A regular Publish URL may not work if it has special characters in the folder name / file name, etc. 

Note: A Safe Publish URL will become invalid if the linked file is modified; a regular Publish URL will 

not be affected if the linked file is modified. 

Also, when other users visit your published (or shared) folder(s), they use your account download 

bytes. If many users visit your published folder, please make sure you have enough download bytes. 

6.2 Manage Publishes 

You can stop publishing a folder, or edit the publishing info. To do so, click Tools, then click “Manage 

My Publishes”. See the screenshot below: 



 

It will display a list of your publishes (published folders). You can double click on a Publish (Share) 

Name to edit the Publish info or view the Publish URLs.  

 

To stop publishing a folder(s), just select it and click Delete. It will delete the Publish only. Your folder 

and files will not be deleted. 

6.3 Access Published Cloud Folders 



You can use Publish URLs to access published folders and files. Just open a web browser and enter 

the Publish URL(s). 

If you need to download published files, using web browser, you can download files one by one. A 

more efficient method is using DriveHQ FileManager. To download multiple published files / folders 

using DriveHQ FileManager, you just need to log on to DriveHQ FileManager (DriveHQ account is 

required), then enter the following address: 

\\USERNAME\PUBLISHNAME 

 

Enter a publish path in the server address bar to access a published folder 

After you enter the Publish Address in the cloud address bar, click on “Go” to open the folder. The 

published folder works just like a regular folder. You can drag and drop (or copy and paste) to 

download the files / folders to your local storage or to your own DriveHQ cloud folder. 

7 Folder Synchronization 

DriveHQ FileManager offers the most powerful folder synchronization features. It can: 



o Synchronize a local folder with a cloud folder.  

o Synchronize multiple local folders with multiple cloud folders. 

o Create multiple sync tasks with different schedules, incl. real-time, daily and weekly. 

o Synchronize multiple computers to the same cloud folder, indirectly synchronize multiple 

computers. 

o Create one-way or two-way sync tasks. 

o Exclude certain files from being sync-ed using wildcard. 

o Synchronize folders in multiple user accounts by using a group shared folder. 

7.1 The Default Sync Task(s) 

The first time you log on to DriveHQ FileManager, it asks whether you want to create a default 

synchronization task(s).  

If you are a standalone user, it will create one sync task to synchronize: 

o Local: “C:\users\WINDOWS_USERNAME\DriveHQSync” and  

o Cloud: “\DriveHQSync” 

If you are a group member user, it will create another sync task to synchronize with a group shared 

folder (i.e. multi-user folder sync):  

o Local: “C:\users\WINDOWS_USERNAME\GroupSync” and 

o Cloud: “\GROUP_OWNER_USERNAME\GroupWrite\GroupSync” 

If you choose to create the default sync task(s), it will start synchronizing your folders immediately, 

similar to other cloud folder sync services.  

The main difference is: It does not sync your entire cloud storage. It only syncs the specific cloud 

folder. Of course, you can store all your data in this folder if you like. DriveHQ advantages are: you 

can create multiple sync tasks to sync multiple folders; you don’t need to sync all your cloud files – 

you can directly edit cloud files and save changes back to the cloud without folder synchronization. 

7.2 Create a Synchronization task 

From DriveHQ FileManager, select a local or cloud folder and then click on Synchronize. It will pop up 

the following dialog: 



 

Click on OK to continue, it will let you select the folder to sync with this folder: 

 

If you want to synchronize it with a new folder, you can click on “New Folder” button, which creates a 

new folder to be sync-ed with the selected folder. Once you have selected the Sync target folder, click 

on Next, it will pop up the following dialog: 



 

Setup folder synchronization dialog 

There are a lot of options / features in this page. Please read the explanations below: 

Synchronization Direction:  

There are three options: Both Directions, Cloud to local only and Local to cloud only.  

Overwrite Direction:  

There are four options: Show Message Box, Overwrite Local, Overwrite Remote and Overwrite Older. 

Synchronization Frequency:  

There are two modes: Real-time and Scheduled. 

In scheduled mode, there are four options: 

o One time only: you can set the starting time to sync it once only. 

o Periodically: you can set the interval for periodically synchronization task; 

o Daily: you can set the starting time for daily synchronization task; 

o Weekly: you can select one day of week. 



Time Delay in Real-time Folder Synchronization 

Once you have created a real-time synchronization task, it will automatically sync the local files with 
the cloud files in real-time as any change occurs. Synchronizing files from the cloud folder to the local 
folder may take a little longer. When a file is changed (or added) in the cloud folder, DriveHQ 
FileManager cannot immediately detect such changes. It may take a few seconds to a few minutes, 
dependent on your number of files. If the synced folder has over a million files, it may take a few 
minutes. 

About One-Way Synchronization 

DriveHQ FileManager supports local-to-cloud and cloud-to-local one-way synchronization tasks. 
Please make sure you understand how it works, otherwise it could cause unexpected file deletion. 

The important thing to know is: regardless of one-way or two-way synchronization, when the 
two folders are synchronized, the folder contents are exactly the same. 

For example a cloud folder S is configured to sync to a local folder C in a one-way synchronization, 
assume S and C are already sync-ed, and now think about these cases: 

(1) If you add a file to S, the file will be sync-ed to C, which is as expected; if you add a file in C, the 
new file is deleted from folder C when next synchronization happens. 

(2) If you change a file in S, it will be sync-ed to C; but if you change a file in C, it will be overwritten; 

(3) If you delete a file in S, it will be deleted in C; but if you delete a file in C, it will be added back. 

In short, if you have a one-way synchronization from A to B, then no matter what happens, after it 
finishes synchronizing, B will become the same as A. 

One-way synchronization can be used for data backup in many cases. Due to the nature of 
synchronization, it will delete files in the destination folder if they are deleted from the source folder, 
which makes it less safe than data backup. If you need real online backup, please use DriveHQ Online 
Backup software.  

Many companies store all their business data on DriveHQ cloud storage/cloud file server. If so, they 
can use a cloud-to-local sync task to back up their cloud files for additional redundancy. 

 

Exclude these files: Define the files to be excluded from the synchronization task. Multiple file 
extensions, file names or file wildcards can be entered, separated by “|”. (e.g.: *.bak|Project*.docx) 

Note: After the Synchronization Task has been created, if you delete or modify a file in a sync-ed folder, 
the change will be automatically applied to the other synchronized folder. To avoid unexpected file 
deletion, FileManager automatically saves a copy of the deleted files in the “_Sync_Cache_” folder 
(which is automatically created in the root of the sync-ed folder). To turn off this feature, you can 
uncheck "Save a backup copy of automatically deleted files". You can also set “Automatically 
delete files in sync cache folder” to 7 days or 14 days. The default value is “Never”. If too many 
deleted files are saved in the _Sync_Cache_ folder, you can also manually click “Clear Sync Cache” 
to delete them.  



Lastly, you can set the task valid time. By default, the task will be valid until 2099.  

Click "Save" to save the task. 

7.3 Manage a Synchronization Task 

Click on "Tools"-->"Manage Synchronization", the "Manage Folder Synchronization" window 
shows up. It displays all sync tasks that were created on this computer. If you created any default sync 
tasks, they will also be displayed  in the list.  

You can disable / enable, start synchronizing, edit or delete a sync task, as shown below. If a sync 
task is running, you can click “Show Progress” to view the detailed sync progress info / status. 

 

Folder Synchronization among multiple PCs and Multiple DriveHQ users 

You can install DriveHQ FileManager on multiple PCs; on each PC, you can synchronize a local folder 
with the same cloud folder. This will synchronize the folders on all PCs. 

To synchronize folders among multiple DriveHQ users, e.g., if UserA wants to synchronize two folders: 
FolderA of UserA and FolderB of UserB, then UserB must share FolderB to UserA (usually with Full-
Access right). When UserA logs on DriveHQ FileManager, he can see FolderB in "\DriveHQ 
Share\UserB\FolderB". He can synchronize the shared folder with his local folder. 



7.4 Sync Status Notification Email and Event Log 

In the above Manage Sync Tasks window, you can click Event Log to display the following dialog: 

 

If you want to receive sync status emails, enter your email address on top. Multiple email addresses 
can be entered, separated by “;”.  

You can check one or both checkboxes on top “When an error happens” and “When a task finishes”. 
It defines when FileManager should send a sync status email.  

In the above dialog, you can click “Clear All” to delete all sync events. If FileManager has a problem, 
click “Send event logs to support”. You shall provide the detailed info about how to duplicate the 
problem. Try to send another email to DriveHQ support with the detailed info and screenshots 
showing the problem. 

8 DriveHQ FileManager Options 

You can configure DriveHQ FileManager based on your preferences. From DriveHQ FileManager 

main screen, click the Options button, it will open the Options dialog: 



 

DriveHQ Options screen – My Options tab 

As you can see from the Options dialog, it has the following features / options: 

• My Profile: Click on it and it will display your account info; you can change it. 

• Account Balance: You can find your account balance, incl. cash balance, service coupon 

balance, max storage, used storage space, max monthly download bytes and used download 

bytes, etc. Please make sure to check if your account balance is correct. If it does not match with 

what you ordered and if you are a group owner, you might have allocated storage space / 

download bytes to your sub-user(s). 

• Change Password: You can change your password. You need to verify your current password 

before you can change your password. 

 

• My Options: As shown above, you can set the following options in this dialog: 

o Remember my logo info: If you checked this checkbox, you don’t need to enter username 

/ password each time. 

o Automatically sign in: When you start FileManager, it can automatically sign in 

FileManager. 

o Directly edit and save cloud files: You can directly edit and save cloud files without 

folder synchronization. 



o Lock the cloud file if it is being edited: FileManager supports automatic file locking. If a 

user is editing a cloud file in a shared folder, the file can be automatically locked. If a 

second user opens the file, it will be read-only.  

o Use cached folder/file list. It is faster, but the list might be outdated: After 

FileManager accesses a folder, it caches the file/subfolder list info. It is faster to navigate 

folders. You can manually refresh a folder to get the updated file/subfolder list.  

o Perform a full comparison of real-time sync-ed folders on start: For real-time sync 

tasks, FileManager monitors the folders for file changes. It does not do a full comparison 

of folder contents. It is very efficient but is not always reliable. If you notice any problem, 

you can check this checkbox, or manually start the sync task. 

o Allow synchronizing open (locked) files: Open (locked) files are files that are being 

written to. DriveHQ FileManager supports “Volume Shadow Copy”. It can synchronize an 

open file if you check this checkbox. Please note an open file cannot be overwritten; for 

that, you must quit the program that opened the file. 

o Save screenshots to cloud storage: If you take a screenshot, FileManager can 

automatically save it to the cloud folder “\My Documents\Screenshots”. If you need to 

share your screenshot, it will be very convenient to share it from the cloud.  

o Play video files with / view image files with: FileManager can directly play cloud video 

files / view cloud image files. You can also use Windows default apps to play or view 

video/image files. 

o Maximum cache file size: DriveHQ FileManager caches the most recently accessed files 

in a local cache folder. The first time you access (open/view/read/modify) a file, it is 

downloaded to a local cache folder. Thus, the subsequent accessing to the same file(s) 

will be many times faster. The default maximum cache file size is 1GB. 

o Location of the local cache folder: the folder location where you saves the cached files. 

By default, the location is like: 

C:\Users\WINDOWS_USERNAME\AppData\Roaming\DriveHQ\cacheDir\CUSTOMER_ID 

You can change the local cache folder location if your OS drive does not have enough free 

space. 

o View Cache Files: click on this button to see the cached file(s). 

o Clear All Cache Files: click on this button will delete all files in the cache folder. 

• Subscription: you can order a subscription plan or manage your subscriptions online. 

• Encrypted Folder: click on Encrypted Folder, you will see this screen. Please make sure to read 

the information carefully. 



 

Encrypted Folder Option 

The encrypted folder feature is a client-side encryption solution. It is extremely secure. 

It offers encryption for cloud files at rest. Combined with SSL which encrypts data for 

uploading and downloading. It offers end-to-end security and privacy. 

If you need extra level of security and privacy, you can use the encrypted folder feature. 

You can enter an encryption key in the above screen. Please make sure you enter a 

long key so that other people cannot guess. After you save the key, it will create a 

folder in your “\My Documents” folder: 

\My Documents\My Encrypted Data\ 

When you upload files to this folder using DriveHQ FileManager (or DriveHQ Online 

Backup), your files will be encrypted locally by DriveHQ FileManager using your 

encryption key. The encrypted files are uploaded to DriveHQ server. The files will 

remain encrypted on server. DriveHQ uses industry strength encryption algorithm with 

proprietary customization; without the encryption key, it is extremely hard to decrypt 

the files. 

When you download the encrypted files on the same computer, DriveHQ FileManager 

can automatically decrypt the files. So encryption and decryption are transparent; no 

user action is required. 

Please note: 



After you have uploaded some encrypted files, if you change the encryption key in 

FileManager, it cannot update the encryption key of those files that have already been 

uploaded. The new encryption key will be used when you upload new files. This is 

because your files are encrypted locally; your encryption keys are never sent to the 

server, so the server cannot decrypt your cloud files, nor can it encrypt them again 

using your new encryption key. It means: you must remember all your encryption 

keys; or you have to download (and delete) all previously uploaded files and re-

upload them. 

• System Options: Please see the screenshot below: 

 

You can set the following options: 

• Whether to automatically start DriveHQ FileManager after you logon Windows; uncheck it to stop 

it from automatically run; 

• Show Hidden files and folders: by default FileManager does not display local hidden files and 

folders (usually system files/folders). These files/folders are also hidden in Windows Explorer. If 

you need to display such folders, just check the checkbox and click “Save Changes”. 

• Automatically start minimized: When you turn on your PC and log on to Windows, DriveHQ 

FileManager will automatically start (which you can disable it); to avoid it from opening the 

application Window, you can set this option. The benefits are: 

o You can avoid opening too many windows right after log on; 

o When you need to use FileManager, you can open it right away as it has already logged 

on. 



-        Use SSL: check this checkbox to transfer data in HTTPS/SSL. It is checked by default. This is 

highly recommended.  

-        Display remote storage on left / Display local storage on left: by default, FileManager displays 

the remote storage on left-hand side; you can change it to the right-hand side. 

• Speed Limits (and Max Concurrent Upload/Download Threads)  

o Set the maximum upload / download speed: 

When you use DriveHQ FileManager to upload / download many large files, it could use your 

maximum bandwidth, making other applications/devices very slow accessing the Internet. To 

prevent DriveHQ FileManager from using too much bandwidth, you can limit the maximum 

upload / download speed. 

 

Configure Bandwidth Throttling and Multi-threaded Upload/download 

DriveHQ servers do not limit your upload speed. The download speed (bandwidth) is slightly 

limited for free service members. For paid members, the download speed limit is very high. 

Most users won’t notice it. If you share/publish files for many users to download, then ordering 

a higher level plan will offer you higher max download bandwidth. 

While DriveHQ has virtually unlimited network bandwidth, your actual connection speed is 

dependent on many factors: 



- File size: smaller files have more overhead. If most of your files are small, it will be slow to 

upload/download. 

- File type: compressible file types such as text files, document files, HTML/XML files, 

database files can be transparently compressed and thus is much faster to upload. 

- Your local Internet connection speed: Many Internet connections are asymmetric, e.g.: 

ADSL and Cable Modem connections. The download speed tends to be much faster than 

upload speed. 

- The specific route from your ISP’s data center to DriveHQ servers. The connection may 

go through many hops. The slowest hop determines the final speed. 

- If you connect to DriveHQ servers from another country, then the speed is usually 

dependent on the connection speed between your country and USA. The connection 

usually has higher latency. FileManager usually can increase the upload/download speed 

by multiple concurrent connections. 

 

o Set the max number of upload/download threads (connections) 

 

If your network bandwidth is very large, but the transfer speed is unusually slow, it might be 

caused by the network latency being too high. If so, you might be able to significantly increase 

the speed by using higher number of connections (threads).  

 

On the other hand, if your network connection is unreliable and if you often fail to upload large 

files, then try to limit the max number of threads to 1.  

 

• (Cloud) Folder Options: 

 



You can set your cloud folder options by clicking on the link “Set cloud folder options”. It will open 

a web browser window for you to set the cloud folder options. After you finish setting your 

options, click Refresh to refresh it in FileManager. 

• Group Account: 

If you are a standalone user, you can upgrade your account to a group account by clicking the 

“Free Upgrade to Group Account” button. The free service offers 1 free sub-user license. 

If your account is a Group Admin account, then you can click “Launch Group Admin Tool” to launch 

the web browser based group admin tool. 

• Lock DriveHQ FileManager App: 

After you log on to DriveHQ FileManager, it will not log off automatically. The logon session does 

not expire. It is designed this way because: 

o You might have automatic folder synchronization tasks. It will fail if it is logged off.  

o A user might be editing a cloud file in MS Word. If it is logged off, the file cannot be 

saved back to the cloud.  

If you are concerned about this design, you can set FileManager to automatically lock after it 

is minimized for a few minutes, or you can manually lock the program without logging off. 

 

9 The “Portable or No-install Version” 

DriveHQ FileManager 

When you use a public computer (e.g. in a library), you may not be able to install any software, incl. 

DriveHQ FileManager; in addition, some big organizations may not allow employees to install any 

software on company computers. In this case, users can use DriveHQ.com web-based service, or 

DriveHQ FTP service (if FTP is allowed).  

DriveHQ has a special version DriveHQ FileManager “Portable or No-install” Edition, which does not 

require installation. You can simply download it and unzip the files into a folder; you can also copy the 

files to a USB drive, or burn a CD/DVD. You can then double click on the executable file 

“DriveHQFileManager.exe” to launch DriveHQ FileManager.  

The “portable or no-install” edition works just like the regular edition, except: 

-        It requires no installation; you can copy and remove the application folder to “install / uninstall” 

the software; 

-        It does not require a cache folder; 



-        It doesn’t integrate with Windows Explorer. It doesn’t add the “right click” menus to Windows 

Explorer; moreover, you cannot drag and drop files / folders from Windows Explorer to 

DriveHQ FileManager. 

-        You do not save your account info; 

-        When you log off, it will prompt you to delete any cached files / folders. 

-        It does not add a small icon in the system notification area. 

As of 8/12/2020, the portable version is no longer available to public. Please contact us if you 

need it. 

 

10 FileManager Trouble Shooting Guide 

10.1 General Guidelines 

• Please upgrade to the latest version of DriveHQ client software from the DriveHQ.com website. You can 

find the detailed version information in the About Dialog. You can open the About Dialog by clicking on 

Help menu, then select “About DriveHQ FileManager”. 

• Please make sure your computer is connected to the Internet and that the connection is reliable.  

• Occasionally, you can reboot your computer or restart DriveHQ FileManager to resolve a strange 

problem. To Exit FileManager, please click the File menu, then select Exit, or right click the FileManager 

icon in the System notification area: 

 
 

If you only close the FileManager main window, it will keep running in the background.  

 

• DriveHQ FileManager has a built-in feature for “sending event logs to support”. The event logs contain 

useful debug information. It will help us locate your problem.  

• If FileManager worked before, then your last resort might be to “Reset All Settings to Original Defaults, 

or Reset Sync Tasks” (it will not delete your sync task or files) 



• Please read the FAQ below before you contact DriveHQ support. Email is the preferred support method. 

Enterprise customers can call/email DriveHQ support. When emailing/calling, please tell us your 

username and the detailed steps to duplicate your problem. A screenshot(s) showing the detailed 

problem is very helpful. 

10.2 Trouble Shooting FAQ 

(1) I just installed DriveHQ FileManager. It cannot connect to www.DriveHQ.com (or cannot log in). What 

could be the problem? 

Please check if you can connect to www.DriveHQ.com website and if you can log on via a web browser.  

- If yes, and if you never installed DriveHQ FileManager on this computer before, then the problem is likely 

caused by anti-virus / security software. Please add DriveHQ FileManager to your anti-virus software’s 

“Allow List” or “White List”. Windows 10 includes Windows Defender and Windows Firewall, you don’t 

really need any 3rd party anti-virus software. 

  

- If no, then you need to check your Internet connection. You can also try to connect from a different 

network. (e.g. using a mobile browser from your smartphone with Wi-Fi turned off). 

 

(2) DriveHQ FileManager on my PC worked fine before. But it cannot connect to www.DriveHQ.com now. 

Why? 

Anti-virus or security software may cause such problems. Please stop / disable your anti-virus software, 

or add DriveHQ FileManager to your anti-virus software’s Allow List or White List.   

If you have a very old version DriveHQ FileManager, please download the latest version from 

DriveHQ.com website. You can download DriveHQ FileManager at: 

https://www.drivehq.com/downloads/downloadfilemanager.aspx 

 

(3) DriveHQ FileManager failed to synchronize a folder. The app crashed or is very slow. How to solve it? 

Application crash is rare. If it rarely happens, you can restart FileManager and try to synchronize the 

folder again. If the problem happens repeatedly, you can disable the sync task before it starts running. To 

do so, please click on Tools -> Manage Sync Tasks to disable the sync task.  You can then click Help -> 

Send Event Logs to Support.  

http://www.drivehq.com/
http://www.drivehq.com/
http://www.drivehq.com/
https://www.drivehq.com/downloads/downloadfilemanager.aspx


 

It will send the event log info to DriveHQ technical support. If you want a reply, please make sure to 

provide the detailed description about your problem.  

(4) You can trouble shoot the folder synchronization problem yourself: 

o Click Help menu, then click “Reset / Clear Cache”. It will display the following dialog: 

 
 

You can reset your sync tasks. It will not delete your sync task data. It just deletes the folder sync 

status info. After reset, it will need to re-sync your files. But it will not upload/download the 

same files. If you like, you can also “Reset all settings to original defaults”. 

   

If reset does not solve the problem, you can manually drag and drop the folders and files 

between the two sync-ed folders. The problem is likely to be caused by certain file(s)/folder(s), 

e.g. a file/folder name contains unsupported characters, or the path being too long, or a file is 

corrupted or locked, etc. You can pinpoint which file / folder caused the problem as follows: 

 

Manually drag and drop half of files/folders in the synced folder. If the problem happens, then 

you need to upload a half of the “half folder”; otherwise, you need to upload the other half of 

the folder. Repeat the process until you can locate the specific folder / file that causes the 

problem. You can exclude the file/folder from being synchronized, or email the detailed 

information to DriveHQ support. To exclude files/folders from being sync-ed, you can click Tools 

-> Manage Sync Tasks, then edit a sync task and enter the file/folder path(s): 



 
 

(5) DriveHQ FileManager is slow in synchronizing a folder. Why? 

The synchronization speed is dependent on your number of files, your Internet connection speed, 

your disk speed and the amount of data that needs to be sync-ed.  

 

If you have huge number of files, e.g. 1 million files, then it is normal that sync is slow. We 

recommend using DriveHQ WebDAV Drive Mapping Tool. You can directly access files in the cloud 

without synchronizing them.  

 

If your number of files are not that large (e.g. 100,000 files), and if the speed was fine before, then it 

is probably caused by app data corruption. In this case, you can reset the sync task (it does not 

delete files or the sync task). You can reset sync tasks from DriveHQ FileManager, click Help menu, 

then select Reset / Clear Cache, then select “Reset Sync Tasks”.  

 

The slow speed problem could be caused by your failing hard drives. If the drive is old, it could 

become very slow due to wear-outs and bad blocks. You can run chkdsk utility on the local drive. 

 

(6) Can FileManager synchronize locked files? 

 

FileManager does not sync locked files by default, so you need to close the program that locked the 

file. However, you can enable FileManager to synchronize locked files to the cloud. Click the 

Options button, it will display the following window: 



 

Check the checkbox “Allow synchronizing open (locked) files”. It will use Volume Shadow Copy technology to 

sync an open/locked file to the cloud. Note FileManager cannot overwrite a locked/open file on your local 

storage. So it can only sync a locked file to the cloud, but not the other direction. 

 

(7) DriveHQ FileManager cannot be installed / uninstalled. Why? 

DriveHQ FileManager uses the standard InstallShield installer. Usually you should not have any 

problem installing or uninstalling.  If you cannot install the software, then please make sure you 

logged on as a System Administrator on the computer. Also, please make sure you don’t have any 

anti-virus software / security software blocking the installer. 

 

If you cannot uninstall the software, please make sure you logged on as a system administrator and 

no security software blocks the installer / uninstaller. 

 

If you still cannot uninstall it, the chance is the uninstaller file has been deleted or corrupted. This 

could be caused by disk corruption, anti-virus software or manual deletion. 

 

To fix the problem, you need to download a newer version DriveHQ FileManager. However, the 

newer version Installer needs to uninstall the older version from your computer first, but you cannot 

uninstall the older version…  To work around the problem, you just need to: 

 

• If DriveHQ FileManager is running, then please quit FileManager first (Click on the “File” menu, 

then select Exit). 

 



• Launch Regedit.exe, then delete the registry key: (see the screenshot below)  

For 64-bit OS: 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\Uninstall\{

D6633044-F22B-46FC-BC8F-3838CA791A7C} 

 
 

For 32-bit OS: 

HKEY_LOCAL_MACHINE\SOFTWARE \Microsoft\Windows\CurrentVersion\Uninstall\{D6633044-F22B-46FC-

BC8F-3838CA791A7C} 

 

Run the installer again. It will directly install the newer version overwriting the old version. If it is 

installed correctly, the uninstaller problem is automatically fixed. 

 

10.3 Contact DriveHQ Customer Support 

If you still cannot solve the problem, you can contact DriveHQ support. (If you are a sub-user of a group 

account, you can also contact your group administrator / IT department). 

Email is the preferred support method. Enterprise customers can call/email DriveHQ support.  

When emailing/calling, please tell us your username and the detailed steps to duplicate your problem. A 

screenshot(s) showing the detailed problem is very helpful. Please also send FileManager’s event log to 

support, see the screenshot below. 

 

 

 


